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You have the following line chart that shows the average sales by month.
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Open the link to Book] found on the desktop, Use the Superstore data source.
Split the Customer Name feld into two fields named First Name and Last Name,
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2026 Die neuesten Fast2test TDA-CO01 PDF-Versionen Priifingsfragen und TDA-CO1 Fragen und Antworten sind kostenlos
verfligbar: https:/drive.google.com/open?id=1mVjnbE88e YRxqzoZvIPmDMs2lifvhoS5r

Fast2test ist eine gute Website, die effiziente Ausbildung zur Tableau TDA-C01 Zertifizierungspriifung bietet. Und Fast2test
verspricht, dass Sie die Tableau TDA-CO1 Zertifizierungspriifing bestehen kénnen. Sonst geben wir Thnen eine volle
Riickerstattung, Vorm Kaufunserer Produkte konnen Sie im Internet teilweise die Demo zur Tableau TDA-CO1
Zertifizierungspriifing von Fast2test kostenlos herunterladen. Dann werden Sie mehr Vertrauen in unsere Prodzkte setzen. Sie
koénnen sich dann gut auf Thre Tableau TDA-CO1 Zertifizierungspriifimg vorbereiten.

Wemn Sie die Schulungsunterlagen zur Tableau TDA-CO1 Zertifizierungspriifung aus Fast2test haben, kénnen Durchemander
entwirren und nervose Stimmung vertreiben. Die Schulungsunterlagen zur Tableau TDA-CO1 Zertifizierungspriifing von Fast2test
sind die genaueste Lehrbiicher auf dem aktuellen Markt, mit denen die Bestehensrate fiir die Tableau TDA-CO1
Zertifizierangspriifing fast 100% betrdgen kann. Wenn Sie Fast2test wihlen, gehen Sie dann auf dem Weg zum Erfolg,

>> Tableau TDA-C01 German <<

TDA-CO01 Tableau Certified Data Analyst neueste Studie Torrent & TDA-CO01
tatsichliche prep Priifung

Um Ihre Tableau TDA-CO1 Zertifizierungspriifingen reibungslos erfolgreich zu meistern, brauchen Sie nur unsere Priifingsfragen


https://drive.google.com/open?id=1mVjnbE88eYRxqzoZvIPmDMs2Iifvho5r
https://www.zertpruefung.de/TDA-C01_exam.html
https://www.deutschpruefung.com/TDA-C01-deutsch-pruefungsfragen.html
https://de.fast2test.com/TDA-C01-premium-file.html

und Antworten zu Tableau TDA-CO01 Dumps (Tableau Certified Data Analyst) auswendigzulernen. Viel Erfolg!

Tableau Certified Data Analyst TDA-CO01 Priifungsfragen mit Losungen
(Q79-Q84):

79. Frage
You have the following chart that shows the cmm]ative of sales from various dates.

You want the months to appear as shown in the following chart.
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‘What should you do?

A. Convert the date to Attribute

B. Convert the date to Exact Date

C. Select Show Misting Values for the dale
D. Convert the date to Continuous

Antwort: B

Begrindung:

To make the months appear as shown in the second chart, you need to convert the date to Continuous. A continuous date is a green
pill that shows a range of values on an axis. A discrete date is a blue pill that shows individual values as headers. In this case, you
want to show a continuous range of months on the x-axis, instead of discrete headers.

To convert the date to Continuous, you need to do the following steps:

Right-click on the date field on the Colunmns shelf and select Convert to Continuous from the menu. This will change the date pill
fromblue to green and show a continuous range of dates on the x-axis.

Right-click on the date field again and select Month (January 2017) from the menu. This will change the level of detail of the date to
month and year, instead of day.

Optionally, you can format the date axis by right-clicking on it and selecting Format from the menu. You can change the scale, tick
marks, labels, and other options.

The other options are not correct for this scenario. Converting the date to Exact Date will show every single date as a header, which
will be too crowded and unreadable. Selecting Show Missing Values for the date will fill in any gaps in the data with null values, but
it will not change how the months appear. Converting the date to Attribute will return only one value for each partition of data, which
will not show any variation over time. Reference: https://help.tableau.com/current/pro/desktop/en-us/dates.htm
https:/help.tableau.com/current/pro/desktop/en-us/dates _continuous.htm https/help.tableau.convcurrent/pro/desktop/en-
us/formatting htm

80. Frage


https://www.pass4test.de/TDA-C01.html

Open the link to Book1 found on the desktop. Use the Superstore data source.

Split the Customer Narme field into two fields named First Name and Last Name.
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Antwort:
Begrindung;
check the steps below in explanation.
Explanation:

To split the Customer Nare field into two fields named First Name and Last Name, you need to do the following steps:

Open the link to Book1 found on the desktop. This will open the Tableau workbook that uses the Superstore data source.

Go to the Data Source tab at the bottom of the workbook to see the data source page. You will see a table that shows the fields
and values from the Superstore data source.

Right-click on Customer Name in the table and select Split from the menu. This will split the field into two fields based on a
separator, which is a space by default. You will see two new fields named Customer Name - Split 1 and Customer Name - Split 2
m the table.

Right-click on Customer Name - Split 1 and select Rename from the menu. Type First Name as the new name and press Enter. This
will rename the field as First Name.

Right-click on Customer Name - Split 2 and select Rename from the menu. Type Last Name as the new name and press Enter. This
will rename the field as Last Name.

References: https:/help.tableau.com/current/pro/desktop/en-us/datasource prepare.htm
https/help.tableau.com/current/pro/desktop/en-us/split. htm

https/help.tableau.com/current/pro/desktop/en-us/renamefield. htm

81. Frage
You want to connect a Tableau workbook to a dataset in a Microsoft Excel spreadsheet.
‘What should you do from Tableau Desktop?

A. From the Data menu select Replace Data Source
B. From the File menu select New

C. Fromthe File menu select Import Workbook

D. From the Data menu select New Data Source



Antwort: D

Begrindung;

To connect a Tableau workbook to a dataset in a Microsoft Excel spreadsheet, you need to select New Data Source fiom the Data
menu. This will open the Connect pane, where you can choose Microsoft Excel as your data source and browse for your
spreadsheet file. You can then drag and drop your sheets or tables to join or union them in the data source page. References:
https/help.tableau.com/current/pro/desktop/en-us

/connect_basic.htm https//help.tableau.convcurrent/pro/desktop/en-us/connect _excel. htm When connecting to a dataset in Tableau
Desktop, you would go to the 'Data’ menu and select 'New Data Source'. This allows you to connect to various types of data
sources, including Microsoft Excel spreadsheets, where you can then select the specific file you wish to connect to.

82. Frage
You have the following box plot that shows the distribution of average profits made in every state by region.
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‘Which region has the smallest distribution of profits?

A. Central
B. South
C. Cast
D. West

Antwort: B

83. Frage

A Data Analyst needs to develop a Sales Dashboard that users can access through a computer or by phone and tablet using the
same URL link.

How should the analyst create dashboards that are formatted for specific devices?

A. Create a workbook for each device type and let the users know which one to open on which device.

B. Use floating containers on the dashboard so that the content shifts responsively to adjust for each device.
C. Set the dashboard size to Automatic and let Tableau adjust the layout automatically for each device size.
D. Add device layouts for the dashboard so that appropriate layouts are shown based on the device.

Antwort: D

Wemn Sie sich noch anstrengend um die TDA-CO01 Zertifizierungspriifing bemithen, dann kann Fast2test in diesem Moment [hnen
helfen, Problem zu 16sen. Fast2test bietet Ihnen Schulungsunterlagen von hoher Qualitit, damit Sie die Priifing bestehen und
exzellentes Mitglied der Tableau TDA-CO1 Zertifizierung werden kénnen. Wenn Sie sich entscheiden, durch die Tableau TDA-CO01
Zertifizierungspriifing sich zu verbessern, dann wihlen Sie bitte Fast2test. Fast2test zu wihlen ist keinesfalls nicht falsch. Unser
Fast2test verspricht, dass Sie beim ersten Versuch die Tableau TDA-C01 Zertifizierungspriifung bestehen und somit das Zertifikat
bekommen kénnen. So konnen Sie sich sicher verbessern.

TDA-CO01 Testking: https//de.fast2test.com/ TDA-CO1-premium-file. html

Tableau TDA-C01 German Sie wissen auch, wie wichtig diese Zertifizierung Ihnen ist, die gut gekaufte Tableau TDA-CO01
Priifingssofteware wird von unserem professionellem Team entwickelt mit groSer Menge Forschung der Tableau TDA-CO1
Priifimg, Um den hohen Standard zu entsprechen, bieten wir 24/7 online Kundendienst, emjéhriger kostenloser Tableau TDA-C01
Aktualisierungsdienst nach dem Kaufund die Erstattungspolitik beim Durchfall, Wenn Sie eine hohe Punktzahl in echter Priifing mit
weniger Zeit beim ersten Versuch bekommen wollen, ist unsere Tableau TDA-CO1 Priifimgsvorbereitung absolut Thre beste Hilfe.

Minner und Frauen, Dadurch, meinte Schiller, vergebe der TDA-CO01 akademische Senat sein Ansehen und seine Wrde, Sie wissen
auch, wie wichtig diese Zertifizierung Thnen ist.

die gut gekaufte Tableau TDA-CO1 Priifingssofteware wird von unserem professionellem Team entwickelt mit groSer Menge
Forschung der Tableau TDA-CO01 Priifing,

Kostenlose giiltige Priifung Tableau TDA-C01 Sammlung - Examcollection

Um den hohen Standard zu entsprechen, bieten wir 24/7 online Kundendienst, einjahriger kostenloser Tableau TDA-C01
Aktualisierungsdienst nach dem Kaufund die Erstattungspolitik beim Durchfall.

Wemn Sie eine hohe Punktzahl in echter Priifing mit weniger Zeit beim ersten Versuch bekommen wollen, ist unsere Tableau TDA-
CO1 Priifimgsvorbereitung absolut Thre beste Hilfe.

Wir sind ein anerkannter Marktfiihrer bei der Bereitstelung zuverldssiger TDA-C01 PDF & Test Engine Dumps fiir IT-
Zertifizierungspriifungen, insbesondere TDA-CO01 Zertifizierungspriifingen.

e TDA-CO01 Ausbildungsressourcen [ | TDA-CO1 Testking [ TDA-CO01 Online Praxispriifing [ Erhalten Sie den
kostenlosen Download von { TDA-CO1 } miihelos iiber  www.zertpruefing.ch ) TDA-CO1 Prifingsunterlagen

e Tableau TDA-CO1: Tableau Certified Data Analyst braindumps PDF - Testking echter Test [ Suchen Sie einfach auf *
www.itzert.com ” nach kostenloser Download von [ TDA-CO01 ] [ITDA-CO1 Fragen Antworten


https://www.zertpruefung.ch/TDA-C01_exam.html
https://de.fast2test.com/TDA-C01-premium-file.html
https://www.deutschpruefung.com/TDA-C01-deutsch-pruefungsfragen.html
https://www.zertpruefung.ch/TDA-C01_exam.html
https://www.pdc.edu/?URL=https%253a%252f%252fde.fast2test.com%252fTDA-C01-premium-file.html

e TDA-CO01 Unterlagen mit echte Priifingsfragen der Tableau Zertifizierung [ Suchen Sie auf - www.zertpruefing.ch
(18] nach> TDA-CO1 < und erhalten Sie den kostenlosen Download mithelos [ITDA-CO1 Priifingsiibungen

e TDA-CO01 Fragen Antworten [ ] TDA-C01 Examsfragen [] TDA-CO1 Echte Fragen [] Geben Sie [ www.itzert.com
1 ein und suchen Sie nach kostenloser Download von [] TDA-CO01 (] [JTDA-CO1 Priifings-Guide

e TDA-CO1 Unterlagen mit echte Priifingsfragen der Tableau Zertifizierung [ | Offhen Sie = www.zertsoft.com & geben Sie
[ TDA-CO1 [ einund erhalten Sie den kostenlosen Download ['TDA-CO1 Exanrsfragen

e TDA-CO01 Mit Hilfe von uns konnen Sie bedeutendes Zertifikat der TDA-CO1 einfach erhalten! [1 Suchen Sie auf (
www.itzert.com ) nach kostenlosem Download von > TDA-CO01 ] ['TDA-CO1 Examengine

¢ TDA-CO1 Priifungsinformationen [ | TDA-CO1 Echte Fragen » TDA-CO01 Zertifizierungspriifing [] Suchen Sie jetzt auf

¢ www.deutschpruefing.com ) nach v/ TDA-CO01 ¢ [J und laden Sie es kostenlos herunter ['TDA-CO1

Schulungsunterlagen

¢ TDA-CO1 Studienmaterialien: Tableau Certified Data Analyst - TDA-CO1 Torrent Priifing - TDA-CO1 wirkliche Priifung []
"1 Offen Sie die Webseite [ www.itzert.com [] und suchen Sie nach kostenloser Download von [ TDA-CO01 [ [/TDA-
CO01 Vorbereitungsfragen

e TDA-CO01 Priifings-Guide [ TDA-CO1 Zertifikatsdemo 1 TDA-CO1 Ausbildungsressourcen [ Offhen Sie die
Website v/ de.fast2test.com [1¢/ [ Suchen Sie > TDA-CO1 < Kostenloser Download [1TDA-CO01 Examengine

e TDA-CO01 Mit Hilfe von uns konnen Sie bedeutendes Zertifikat der TDA-CO1 einfach erhalten! [1 { www.itzert.com } ist
die beste Webseite um den kostenlosen Download von ¢ TDA-C01 [1°8: ] zu erhalten [/'TDA-CO1 Zertifizierungspriifing

e TDA-CO1: Tableau Certified Data Analyst Dumps - PassGuide TDA-C01 Examen [ Offhen Sie die Website [ www.it-
pruefing.com ] Suchen Sie [ TDA-CO1 ] Kostenloser Download [ I TDA-CO1 Zertifikatsdemo

o www.stes.tyc.edu.tw, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw, www.stes.tyc.edu.tw,
www.stes. tyc.edu.tw, www.stes.tyc.edu.tw, learn-step.com, www.stes.tyc.edu.tw, daystar.oriontechnologies.com.ng,
Disposable vapes

BONUS!!! Laden Sie die vollstéindige Version der Fast2test TDA-CO1 Priifingsfragen kostenlos herunter:
httpsv/drive.google.comvopen?id=1mVjnbE88e YRxqzoZvIPmDMs2lifvhoSr
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